
4D Paint Demo Tutorial

This document walks you through a short introduction to the power of 
4D Paint.  You may want to print a copy (13 pages) so you don't have 
to toggle back and forth between 4D Paint and Write.

Before you begin you should have installed the 4D Paint Demo as 
described in the file 'Readme.txt".

For information on ordering:

In the US, contact 4D Vision on: 800-252-1024 (Toll Free) or go to 
http://www.4dvision.com

Outside the US contact 4D Vision Asia (in New Zealand) on +64 9 309-
3204 or 
email 4dvisasia@cads.co.nz or visit our web site at 
http://www.4dvisasia.co.nz

Licensing

This version of 4D Paint has had its save functions disabled and the 2D 
Views have a '4D Paint Demo Version' banner printed in to them. You 
are not permitted to use this demonstration version of the software for 
output, commercial or otherwise. It is licensed for use only to try the 
features 4D Paint provides within the package itself.  

The 4D Paint Demo Version

This demonstration version of 4D Paint is save and import disabled. It 
allows you to open .4dp files, which use the internal format used by the
application, but does not allow you to use .3ds files or the integrated 
3D Studio MAX interface system the full version comes with.

This 4D Paint demo runs as a stand alone application in Windows NT or 
95.

Using the 4D Paint Demo version

Welcome to the demo version of 4D Paint 1.0. This document is 
intended to get you started using the package an exploring the sort of 
things the release version of 4D Paint can do.

If you follow this tutorial you will see some of the major features 



provided by 4D Paint. After the tutorial feel free to experiment with the 
other functions and features of the package.

1) Loading A .4dp File

The .4dp format is the internal format provided by 4D Paint. To load 
one you need first to open the application, there are two ways to do 
this depending on your system.

To open the demonstration version of 4D Paint as a stand alone, 
double-click its icon or name in the folder in which it was installed, 
either in the File Manager or Explorer.

Select 'Open' from the File menu. When you select this option a 
dialogue appears prompting you to select a file. Locate the file 
'head.4dp' in the 'Head' directory that was installed with your 
4DPDemo directory. When you have selected it click 'OK'.

After a short pause to generate rendering information the head object 
will appear in 4D Paint's Main View. 

2) Painting a few strokes

Let's let you paint a few strokes and rotate the object to get a quick 
feel using the default settings, then we will explore some of the real 
power of 4D Paint.  Once you load the head, you are looking at the 
front view of a 3D head model.   The current paint color is white and 
the current brush is the default brush, which is quite coarse, but let's 
just paint some white eyebrows on the head, then rotate it.  The brush 
tool is already selected, so do the following:

o Position the mouse pointer over the eyebrow area to be 
painted

o Press and hold down the left mouse button
o Drag to paint a stroke representing an the eyebrow
o Release the left mouse button

Repeat for the second eye.

o Click the Rotate icon (on the top tool bar to the left of the 



zoom icon)
o Press and hold down the left mouse button on the head
o Move the mouse to reposition the head
o Release the left mouse button
o Paint another stroke on a different part of the head

3) What You See

Now let's explore the interface and tools.  Reload the head by selecting
'Open' and selecting 'Head.4dp' again.  When 4D Paint first loads, you 
are presented with a single window that contains an area in which the 
imported object is rendered, a series of menus and toolbars that sit 
across the top of the window and a large control panel that sits to the 
right of the window.

Render View: This window contains a rendered version of the object 
you imported. The quality of rendering ranges from Wireframe to 
Smooth Rendered with Bump.

Toolbars: There are two toolbars, a File Toolbar that contains file utilities
and preferences buttons and a Position toolbar that contains tools for 
positioning your objects. The File Toolbar appears to the left and the 
Position Toolbar to the right of that.

Control Panel: The large panel to the right is the control panel, from 
here the major functions of 4D Paint can be accessed. The top two 
rows of buttons are for painting tools, the two rows of buttons at the 
bottom are for utilities and the space in between is used to show the 
controls available for the tool/utility currently selected.

4) Using the Control Panel

When you import an object the Brush Tool is automatically selected. 
This is the button at the top left of the Control Panel. You can tell it's 
selected because its button turned blue.

The two rows of buttons at the top of the Control Panel are latching, 
that is to say when you press them once they stay on until you press 
them again. This is because they activate or deactivate the tool they 
refer to. If you select another button from these top two rows the 
previously selected button is deselected for you. If you select a button 
from the bottom two rows the tool button you had selected will remain 
selected (you can tell by the way it remains blue) but the controls for 



the other button you pressed will appear in the space in the Control 
Panel. While these controls are visible you can still use the Tool Button 
you selected from the top two rows, if you want to make its controls 
appear again just click it once, the controls of the Utility Button 
selected will vanish and be replaced with those of the Tool Button.

The Control Panel is dockable, that is to say you can drag it away from 
the right hand side of the window in to a floating palette of its own, or 
you can dock it on the left hand side of the window.

5) Painting With The Brush Tool

The Controls of the Brush Tool appear when it is selected. They consist 
of two selection boxes, each of which has three buttons associated 
with it, Edit, New and Delete. These two selection boxes are for 
choosing your 'Brush' and 'Paint'.

The 'Brush' can be thought of as the tool used to apply Paint to the 
surface of an object. The default Brush is a large feathered circle that 
has no special attributes. Other brushes include square, elliptical, 
rectangular, hard and soft brushes and additional features such as 
control over the amount of space between each dab of paint the Brush 
applies when it is used.

The 'Paint' can be thought of as the stuff applied to the surface of an 
object by a Brush. Paints contain attributes such as which map types 
are painted by the tool you use, whether the paint is dirty and a 
number of special effects described later.

Brushes and Paints work together, the attributes of the two are 
combined when you paint with a tool such as the Brush Tool. The 
reason they are split is to make it easier to create a wider range of 
painting effects. You could for example have an Oil Paint that paints 
color, shininess and bump on to an object. That Paint could then be 
painted with any of the Brushes you have in your scene just by 
selecting another Brush.

Next to the name of the Brush in the brush selection box is a small 
preview of the shape of the Brush Head. Next to the name of the Paint 
in the paint selection box is a set of icons depicting the Map Types that 
that paint is applied to when used. The Default Paint is only applied to 
the color map.

For now let's keep to the Default Brush and the Default Paint that are 
automatically selected at the start of each session of 4D Paint. The 



Brush Tool is the most straightforward of the painting tools, it allows 
you to paint freehand strokes on to the surface of an object. to paint 
with the brush tool follow these steps:

o Position the mouse pointer over the area to be painted
o Press and hold down the left mouse button
o Drag to paint a stroke
o Release the left mouse button

As you drag a stroke of paint is applied, the default color for paint is 
white.

Paint a few strokes and notice how the bump map applied to the object
stays visible as you paint.

6) Undo

4D Paint provides as many levels of undo as you assign it memory to 
cope with them. To assign memory to the Undo buffer look in the 
preferences section of the File Menu. 3 meg is a good size, 1 meg is 
enough for average paint operations.

When you perform an action the changes you make are stored in the 
Undo Buffer. If you make more changes than will fit in the buffer the 
remainder of the action you made will overwrite the start of the buffer. 
This means that when you Undo, not all of the action you took will be 
undone. The solution to this is to make sure you have enough memory 
assigned to the undo buffer.

When you have Undone something you can also Redo it, you can redo 
as many times as the memory you allocated to Undo can store actions.

We also provide a 'sub-stroke undo' that allows you to undo single dabs
of paint from within a stroke you have painted. This way, if you paint 
slightly over the edges you can undo just the last few pixels of the 
stroke you made.

7) The Fill Tool

Now that you have painted a few strokes we can use the Fill Tool to fill 
an area. The Fill tool is the second button from the left in the top row of
Tool Buttons. It shows a picture of a bucket pouring paint. Click it once 
to activate it.



The Fill Tool provides three kinds of fill operation, Flood Fill which fills 
an area of color similar to the color of the pixel you click, Border Fill 
which fills an area of color outwards from the point you click until it 
reaches a colored border and Fill All that fills an entire map type 
regardless of the original contents.

The Fill Tool uses the current Paint to fill with, this means that special 
effects paint you may have selected such as checkers, stripes, blur etc.
will apply themselves to a filled area just as a normal paint would. At 
the moment we'll keep with the Default Paint.

The default settings of the Fill Tool tell us that to define the area filled 
we're going to 'reference' the color map (if you want to fill using the 
bump map as a reference you can select 'bump' in this window) and 
we're doing a Flood Fill with a tolerance of 32.

Tolerance is important to the Fill Tool, in the case of a Flood Fill it 
defines how different a color can be from the first pixel you clicked for 
it to be filled. For example, a tolerance of 0 would mean that only 
adjacent pixels of exactly the same RGB value as the pixel you clicked 
would be filled, a value of 32 allows a 32 variance in RGB to be filled 
meaning you get a feathered fill. With a Border Fill the tolerance value 
defines how tolerant the fill is of the border color, see below for 
information on that.

Let's change the color of the paint and fill one of the paint strokes you 
applied. To change the color we need to select the Color Picker tool 
which is the second button in from the left on the bottom row of the 
bottom set of buttons on the control panel, it depicts RGB circles 
overlapping.

When you press this button the Color Picker appears. For now let's 
keep it simple, if you right click on the Color Picker you are presented 
with a menu containing a number of colors. Let's fill the stroke with 
Red, select the Red option and the Foreground Color sample turns red. 
Close the color picker with it's close box.

The color is now red, Flood Fill is selected and you have a color paint:

o Position the mouse pointer inside one of the strokes you 
painted

o Single click the left mouse button

After a short pause the stroke will be filled with red. Depending on how 
much feathering there was to the edges of the stroke you may be left 
with a white 'halo' where the Fill did not apply itself, the tolerance 



value can be adjusted to avoid this in the future.

8) The Line/Polygon Tool

As well as freehand painting 4D Paint allows you to paint straight lines 
and polygons. Select the Line Button which is the third button along 
the top row of buttons in the control panel. It depicts a line, a circle and
a square.

The top three options allow you to choose whether you are drawing 
lines, circles or N-Gons. An N-Gon is basically a polygon with a number 
of sides defined by the N-Gon Sides edit box beside it.

The Line Tool also allows you to select a Brush and Paint for the 
operation. Let's get more adventurous now, we can keep the default 
Brush but let's select the 'Checkers' paint. To select a paint click the 
down arrow just to the right of the Paint Selection Box and a list of 
paints appears. Scroll down until you have located the Paint called 
'Checkers'. Single click its name and the list vanishes, Checkers is now 
visible in the selection box.

With the line option still selected follow these steps:

o Position the mouse pointer over the starting point of the 
line you want to draw

o Press and hold down the left mouse button
o Drag the mouse to the end point of the line
o Release the mouse button

After a short pause the line appears, painted using the Brush and Paint 
you selected. Notice that the Checkers Paint has applied checkers 
along the path of the line, Red checkers (the foreground color) and mid
grey checkers (the background color).

9) The Text Tool

If you want to add text to the surface of an object you can use the Text 
Tool. The button for this tool is the far left button on the second row of 
Tool Buttons, it depicts a letter 'T'.

When you select this button the controls for painting text appear in the
Control Panel. These consist of a Font name box that tells you what 
Font style you have selected, and a choose button that allows you to 
change the font, a text entry box that allows you to enter a line of text,



a create button that creates the text and a Paint selection box for 
choosing the Paint that the text will be written with.

To add some text:

o Select the 'default' paint from the top of the Paints list
o Select a font, sized around 14
o Enter a few words in the text entry box
o Click 'Create'

At this point the text is created and the Selection Tool is selected from 
the Control Panel. However, you won't see anything on the screen. This
is because you need to position the text.

o Single click on the object in the rough area you want the 
text to appear

A preview of the text appears underneath the mouse pointer. You can 
now position that text by clicking and holding down the left mouse 
button and dragging to move it.

When you are happy with the position of the text press the 'Drop 
Floater' button that appeared with the selection tools in the Control 
Panel, that commits the text to the surface of the object.

10) The Sampler Tool

One along from the Text Tool (one in from the left on the second row of 
Paint Tools) is the sampler tool, depicting an eyedropper. This tool 
allows you to sample color from the surface of an object in to the 
Foreground or Background colors in the color picker.

When you select the sampler button the area of the Control Panel that 
usually contains controls goes blank, this is because there are no 
controls associated with the sampler.

To sample color to the foreground:

o Click on the color you wish to sample

You can also click and drag if you wish to locate a specific color that is 
hard to click on first time. If you have the color picker open you can 
see the colors you are sampling.

Hold down the Control key while you are sampling to sample color to 



the Background color instead of the Foreground.

11) The Eraser Tool

The Eraser tool is used for removing paint you have applied to an 
object. Its button is located one in from the right on the second row of 
Paint Tools, it depicts a simple eraser.

When you select the Eraser button a set of tools appears in the Control
Panel. These are a Brush selection box for selecting the Brush that will 
act as the head of the eraser and a series of Map Type check boxes 
that allow you to choose which Map Types will be erased when you use 
the tool.

To use the eraser tool simply select a Brush and make sure the Map 
Types you wish to erase are selected correctly from the check boxes 
(for the moment leave them all selected) then:

o Position the mouse pointer over the area to be erased
o Press and hold down the left mouse button
o Drag to erase

Because you are currently erasing on what is called the 'Base Layer' 
(more on Layers later) when you erase the area erased will change 
color to that of the background color. As you erase the bump map that 
provided the head with some texture will be made flat.

12) The Selection Tool

The Selection Tool is used to select areas to be manipulated. Once you 
have selected an area you can Cut it, Copy it or Move it. When you 
have cut or copied a selected area you can also Paste it. The full 
version of 4D Paint allows you to Cut, Copy and Paste to and from 
external applications. In this demonstration version you may only Cut, 
Copy and Paste inside 4D Paint.

The Selection Tool button is the button to the far right of the second 
row of Paint Tools, it depicts a yellow cursor surrounded by a dotted 
rectangle. When you click it a set of tools appear in the Control Panel. 
These tools are a set of check boxes you use to define which Map 
Types are affected by your Cut, Copy, Paste and Move operations, two 
flip buttons used to flip selections and a 'drop floater' button that is 
used to commit changes you have made to the surface of the object 
you are painting.



As a demonstration let's copy and move a small area of skin.

To select an area:

o Position the mouse pointer over the top left of the area you
wish to select

o Press and hold the left mouse button
o Drag the pointer to the bottom right of the area you wish 

to select
o Release the left mouse button

The area encompassed by the rectangle that appears is now selected. 
If you wish to select a new area repeat the process starting your 
selection from a point *outside* the existing selection rectangle.

To copy the selected area:

o Select 'Copy' from the Edit menu

To move the selected area:

o Position the mouse pointer inside the selection rectangle
o Press and hold down the left mouse button
o Drag to move the selected area

As you drag the color and bump that have been applied to the object 
move.

Once you have started a Move operation the selected area becomes a 
'Floater'. Floaters are areas that can move around without deleting 
paint from beneath them. When you have finished manipulating a 
floater you must press the Drop Floater button in order to commit the 
changes you have made back to the surface of the object. Press this 
button now.

Because we copied the selection before moving it we can paste a copy 
back to the object.

o Select 'Paste' from the Edit menu

As with text, 4D Paint now needs to know where to paste the selection. 
Single click on the object and the selection will appear again. You can 
now manipulate it as any floater, remember to 'Drop' it once you have 
finished.



During any of these operations you can change the Map Types that are 
being used by altering the check boxes. For example if wish to paste 
only the bump map of the area selected select paste as normal, click to
position the floater then deselect the 'Color' check box and the color 
you pasted will vanish.

13) Other Map Types

So far we have only painted in to the Color map applied to the object. 
Now that we've looked at the painting tools (bar one we will deal with 
after this) let's paint some bump on to the object.

Because we already have a bump map applied the only thing we need 
to do to paint bump is to select a Paint that applies itself to the bump 
layer.

o Select the Paint Tool

We're going to paint freehand bump on to the object. From the Paint 
selection box that appears select the Paint named 'Bump'. The little 
icon at the side of the Paint name tells you that this paint only applies 
itself to the Bump map.

The bump map that was already applied to the object was fairly dark. 
The default 'intensity' for Bump Paint is white (the highest 'up' bump). 
This means that when we paint on to the surface the bump will be an 
'up bump'. Paint a few strokes to see the effect.

If you want to change the intensity of the Bump you need to use the 
Full Color Picker. This is basically the standard color picker with some 
extra sliders added on to the side. To open it, open the normal color 
picker and press the 'Full Color Picker' button at the bottom.

When you press this button the color picker expands and you have 
access to greyscale gradients for Bump, Self Illumination, Opacity and 
Shininess as well as custom color boxes and RGB sliders.

To alter the intensity of a non-color map type simply drag inside its 
gradient box with the mouse button held down. Try dragging bump to 0
('down bump') and then painting over the bump you painted 
previously. This time a dent is made.

14) Bitmap Paints



Now that we have painted with another map type we can look at 
Bitmap Paints. Bitmap Paints are designed to allow you to paint pre-
made textures directly on to your object with a single stroke, for 
example we have provided you with a Bitmap Paint called 'Frog Skin'. 
The Frog Skin texture consists of a Color map and a Bump map that 
were created outside 4D Paint. Using this Bitmap Paint, we can paint 
that texture onto the object.

Another use of Bitmap Paints is to 'spray' sections of a texture (texture 
being defined as a series of bitmaps relating to the different map 
types) on to an object.

First we'll deal with freehand painting of Bitmap Paints. To do this we 
need to select the Texture Paint tool. The Texture Paint button is 
located at the far right of the top row of Paint Tools, it depicts a small 
square with a bumped material inside it and a green border. When you 
select this button a variety of controls appear in the Control Panel.

The first set of controls allows you to select a Clone or Texture Paint 
operation, Clone copies areas of a material you have painted to other 
areas, Texture Paint uses a Bitmap Paint as a source for a similar 
operation. Beneath those options is a set of check boxes used to define
which Map types are cloned when you use the Clone option. Below that
is a Brush selection box for selecting the Brush that will be used to 
Clone or apply Texture Paint then finally a Texture Paint selection box 
that contains all of the Bitmap Paints you have available.

<<Specify to be sure the texture paint icon is used, not the brush!  >>

For now, with the Texture Paint icon (upper right, top row) selected, 
select the 'Frog Skin' Texture Paint, then click the 'Texture Paint' option 
just beneath the Clone option at the top. When you select this option a 
small window appears that contains a preview of the color map 
element of the Texture Paint. By default when you start to paint the 
source for the paint applied is the center of this image. If you wish 
another part of the image to be the source simply click it in the 
preview window.

Now that you have selected these options you can start to paint. Paint 
a stroke as if you were using the Brush Tool. This time however you will
notice as you paint that you are painting Frog Skin rather than normal 
paint. Because the Frog Skin Bitmap Paint has both a color map and a 
bump map both are applied to the object.

The other way to apply Bitmap Paints is to use the Brush Tool. Select 
the Brush Tool and we'll paint using the 'Bathroom Tiles' Bitmap Paint.



The difference between this method and the previous is that while the 
Texture Paint tool paints freehand strokes of texture, the Brush Tool will
paint a sub-section of a Bitmap Paint on to an object with every dab. 
Select the 'Bathroom Tiles' Paint from the Paint selection box in the 
Brush Tools window. Before we paint with this select the 'Auto Dab 
Spacing' Brush from the Brush selection box. This Brush will 
automatically control the distance between the tiles that are painted 
on to the object so that they are aligned properly.

Paint a stroke. As you paint you will see bathroom tiles with bump 
belong applied to the object. Notice that the edges of each one match 
up with the others, due to the Auto Dab Spacing Brush.

To understand why the Paint appears as it does we should now look at 
the Edit Paint option.

15) Editing A Paint

Now that we are in the Brush Tool window and we have a Bitmap Paint 
selected click the 'Edit' button just above the Paint selection box. This 
brings up the Paint Edit window.

The layout of this window differs depending on the type of Paint you 
are editing. In the case of a Bitmap Paint the box consists of a Name 
entry box, a Paint Type box that says 'Bitmap Paint', a notes box for 
you to enter notes about the Paint and an information box that 
contains special information regarding Bitmap Paints. These controls 
are common to every Paint Type.

The controls specific to Bitmap Paints appear beneath those. A preview
window in which you can see a preview of the Bitmaps that make up 
the Paint, a set of controls for defining how the bitmap is divided and 
how the resulting divisions are applied and a set of edit boxes for 
entering the names of the bitmaps used in the Paint.

In the case of the Bathroom Tiles Paint we can see a bitmap containing 
nine bathroom tiles in the preview window. This is the original bitmap 
from which the smaller tiles you painted were generated. Next to the 
preview we can see that the Divisions are set to 3 by 3, that is to say 
when you paint the bitmap in the preview is split in to 3 tiles 
horizontally by 3 tiles vertically. Every time a dab is painted it will be 
one of these tiles. Underneath that we see that they are applied 
randomly, every time a dab is applied a random one of those tiles is 
painted. If they were applied sequentially each dab would paint the 



next tile in order let to right, top to bottom. Finally, the Color Map and 
Bump Map edit boxes contain the locations of the bitmaps that make 
up the paint.

If you want to have dabs that are not rectangular in shape you can 
define an Alpha Channel bitmap that contains a greyscale transparency
mask to be applied to the Bitmap Paint.

If you click OK and select the Default Paint for editing you can see the 
other parameters that are available.

o Select the <Default Paint> from the paint selection box
o Click 'Edit'

The dialogue that appears is slightly different this time. The top set of 
controls is the same as for a Bitmap Paint (aside from the fact that the 
Paint Type is 'Default' rather than Bitmap Paint) but the controls 
beneath are different. First is a set of check boxes that tell the Paint 
which Map Types it is to apply itself to. For the Default Paint only Color 
is selected. Any combination of Map Types can be painted 
simultaneously. Underneath those is a set of controls for 'Wash' and 
'Highlight' paints. Wash paints will only paint on areas where the Bump 
layer you have selected is Lower than the value in the edit box next to 
it. Highlight paints will only paint on areas higher than that level. 
Finally there is a 'dirt' slider. The Dirt slider allows you to add dirt to the
map types applied when you paint. Dirt is used to add an element of 
realism to the color of the Paint. Rather than applying a single solid 
color it applies grain as it is painted. This can also be useful for 
creating noise maps.

If you choose other Paint Types an extra slider may appear at the 
bottom with other parameters for special paints.

16) Moving An Object

Now that you have painted an object we can take a look at the move 
tools. They are available in the Position Toolbar at the top of the 4D 
Paint window. To use these tools simply click them once, they latch on 
and remain selected until you have finished one use of them. After a 
single use they deselect themselves and re-select the tool you had 
previously selected. If you wish these tools to latch until you click them
a second time single click the Lock button next to the first move tools.

Lighting Position Tools: On the Position Toolbar there are also 3 lighting 
buttons. These are 'Lock Lights To scene' that causes the spotlight to 



remain static while you move an object (if this is not selected the 
spotlight rotates with the object), Light To Front that moves the 
spotlight to point directly at the scene and Rotate Lights that allows 
you to click, drag and rotate the spotlight in the scene. This last one 
can be useful when viewing bump maps.

The Move Tools are:

o Zoom Extents: Zooms the scene so that all objects fit in the
viewport

o Rotate: Press the mouse button and drag to rotate the 
objects (Hold down Ctrl

to rotate on the Z axis)
o Zoom Dynamic: Press the mouse button and drag up or 

down to zoom
o Zoom Window: Drag a rectangle to be zoomed to fit the 

screen
o Pan: Press the mouse button and drag to pan the objects

17) Layers

If you have experimented with the controls, and specifically different 
types of Paint, you may have come across Layers. Layers are a subset 
of Map Types which in turn are a subset of Materials. here's how it 
works:

In 3DSMAX you assign Materials to an object, those Materials consist of
Map Types. 4D Paint imports those Materials and Map Types but also 
allows you to assign more than one Layer per Map Type per Material. 
When you import a Map type, a color map for instance, it becomes a 
'Base Layer' in a Material. Imagine being able to add sheets of glass on
top of that on to which you can paint without losing the paint on the 
Base Layer. This is what layers are. 4D Paint allows you to assign up to 
20 per Map Type, per Material.

If you select the Layers button from the control panel (one in from the 
left on the top row of Utility Buttons, depicting three overlapping 
sheets of paper) you will be presented with Layer controls. These are: 
A list of the Materials in the scene (select a Material to edit its layers), 
a set of 5 tabs that relate to the Map Types. They are Color, Self 
Illumination, Bump, Shininess and Opacity.

When you select a tab a list of layers available for that map type 
appear. Every map type has a 'Render Layer' that is View Only, you 
cannot paint in that layer but if you open it it will show a composited 



version of all the other layers in the Map Type.

If you wish to paint a Map Type that only has a render layer you will 
need to add a new layer by pressing the 'New' button beneath the 
layers tab box. Single click a Layer to select it for painting.

If you add a new layer to a map type that already has a paintable layer
in (a base layer) the new layer will be completely transparent. To select
that layer for painting make sure it is selected in the Layers list by 
single clicking on it. When you paint on that layer the paint you apply 
will obscure the paint on the layer beneath but if you use the eraser to 
erase the paint from that layer the paint on the layer beneath will still 
be there. This allows you to experiment without needing to worry about
damaging work you have done previously.

If you double click on a Layer in the Layers list a 2D view containing 
the bitmap that makes up that Layer will appear. You can paint in this 
2D View using the normal Paint Tools and the 3D object will update at 
the same time. If you have opened a 'Bitmap View' for a layer above 
the Base Layer, clicking the 'Alpha Checkers' button in the bitmap view
toolbar will place white/mid grey checkers in places that have no paint 
(alpha value of 0, completely transparent). If you wish to overlay the 
flattened mesh of the object you are painting on to this 2D view simply
click the view mesh button next to the alpha checkers button. This will 
overlay a wireframe expansion of the object mesh that can be used as 
a positioning guide. When you paint your paint will be applied 
underneath that mesh and at any time you can switch off the mesh 
button and the mesh will vanish leaving your paint unaltered.

18) Lights

By selecting the Lights button (one in from the right on the top row of 
utility buttons, it depicts a light bulb) a set of controls appears in the 
Control Panel.

The top two sliders are for controlling the intensity of the Ambient and 
Spot lighting in the scene. The higher the ambient light the less 
contrast you get on an object so the harder it is to see bump maps. 
These lights range from 0% intensity (slider dragged to the far left) to 
100% intensity (slider dragged to the far right) but their total value can
never exceed 100% combined, that means that as you drag one of 
them past the 50% point, the other (if it is higher than 50%) will slide 
downwards to balance their combined value.

There is also a backdrop slider for controlling the intensity of the 



backdrop.

On fast machines you may want to have the 'Auto Update' check box 
checked, this updates the lighting and backdrop changes you make as 
you make them. If it is not checked, press the 'Apply' button to apply 
changes you make to the scene.

19) Bookmarks

The Bookmarks button is the leftmost button on the top row of Utility 
buttons, it depicts a 3D Studio Viewport Configuration icon.

Bookmarks are custom viewpoints. When you import an object 4D Paint
generates six bookmarks: Top, Bottom, Left, Right, Front and Back. You 
can add bookmarks of your own when you have positioned an object in
a way you want saved. To add a bookmark press 'New'. To set the 
viewpoint to one stored in a bookmark, double click the bookmark's 
name in the list of bookmarks.

Experimentation

4D Paint is a large application, it does a lot more than we have covered
here. This was just to give you a brief look at the sort of capabilities the
package has, it's impossible to cover the lot in anything less than a 
manual. Experimentation is really the only way to discover everything 
it can do, short of getting the actual product.

A Note

If you have a Wintab compliant pressure/context sensitive graphics 
tablet 4D Paint supports pressure sensitivity. If you have a Spacetec 
Space Controller we also support that, look in the Preferences section 
of the File menu to get some controls for it.


